LabelTrace Basic User Guide
For Version RT19.126 – includes installation guidance at end
see www.quicktrace.co.uk/support for earlier LabelTrace Release 18.

Printing a Label Set
- Select the patient in the clinical system
- Click the button / select menu option to launch LabelTrace

- Click on the required menu tab then the name of the required label set.
- Confirm data for any supplementary fields displayed (defaults generally OK).
- Click the button on the keypad to specify the number of sets of labels required (or
enter the required number of sets up to 9999 and click Print).
- Confirm in any confirmation dialogue that you wish to proceed. (optional: system may
require confirmation of correct patient and/or if continue with no CHI/NHS/H&C
number).
The label sets will be printed.
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Points to Note re Operation of LabelTrace
After launching LabelTrace from a clinical system, the option “File/View raw data”
displays a list of the data transferred from the clinical system.
LabelTrace may be launched with dummy data for test purposes via the menu option
“Start > All Programs > QuickTrace > LabelTrace > Test with dummy data”.
The menu system can be configured to have up to nine tabs, each with up to six label
templates available for selection. It is possible to specify a default tab for a workstation.
To do this, click on the tab you wish to make default to bring it to the front then click the
“Default Tab” button – see screenshot above. Each template may comprise one label
design or a set of label designs with one or more identical copies of each. The currently
selected template is indicated by a highlighted "radio button" next to the name.
“Metaprinter” templates are those using the generalised label description language,
Metaprinter, developed for LabelTrace.
In addition to basic patient demographics obtained from the clinical system, LabelTrace
allows selection of up to eight supplementary data fields. These are stored in the
LabelTrace database (Doctor, Premises, User fields) or defined in the template or
defined in the demographic data set. Defaults may optionally be specified. To select an
entry for one of these fields, click on the down arrow to the right of the field and click
on your selection in the resulting list. Only those supplementary fields required for the
currently selected template are displayed.
In the case of the “Doctors” field, each entry may include a “username” field. Each time
LabelTrace is launched, the data passed for currently logged on username in the clinical
system is compared to the “username” field for each Doctor entry and if a match is
found, the corresponding doctor name is set as default. This over rides the normal
default doctor name, if any.
The Premises field is designed to hold practice data for the main and branch surgeries.
The User fields can be used to store multi-choice lists of information for selection at print
time, e.g. lists of clinics, diseases, risk factors etc.

On-screen Buttons
Default Tab: If more than one tab of templates is displayed, that which will be visible
when vLabelTrace launches can be selected using the Default tab button. To do so, bring
the required tab to the front then click the button. This selection is then stored and used
each time LabelTrace is launched.
Preferences: This button is used to set various options such as the printer to be used etc.
See below for details of its use.
Mgmt Utility Button (optional): The LabelTrace database is managed via the LabelTrace
Management Utility which may be installed in addition to, or independently of, the
LabelTrace client. If installed, a “Mgmt Utility” button will be displayed allowing it to be
launched directly.
Help: the “Help” button launches the web browser and loads the URL specified in your
LabelTrace system for user help. This by default will be the document you are currently
reading or it may be a location or document specified by your practice or other local
NHS organisation.
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“Close” Tickbox – important:
important: The “Close” tickbox should normally be ticked and the
action set to “after losing focus”. This ensures that it is not possible to change the patient
in the clinical system then return to LabelTrace without re-launching it. This avoids the
risk of printing labels for the wrong patient. The Close option will normally be greyed
out to avoid users changing it. This can be re-enabled from the Management Utility, if
necessary.
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Setting Preferences
Before printing from LabelTrace for the first time after installation or when changes are
required, you should set your preferences by launching LabelTrace and clicking the
Preferences button.

The options are presented on four tabs.

Defaults Tab

Specify the default selection for each supplementary data field (i.e. which entry is visible
when LabelTrace opens) by choosing it from the drop down list or leave blank if no
default is preferred. All current defaults may be simultaneously cleared using the “Clear
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Defaults” button then any new defaults selected.

Printers Tab
LabelTrace supports up to 9 independently specified printers. These are numbered 1-9
with 1 being the default label printer, i.e. the one to which data will be directed unless
the template has instructions specifying another printer. Several parameters may be
specified for each printer.

“Port” - The port to which to which data should be sent may be specified by selecting
from a drop down list. The options are:COMn: directly to COM Port n (“serial connection”)
When printing to local Com port, if you are uncertain which port the printer is
connected to, try each in turn - it is likely to be COM1 or COM2.
LPTn: directly to LPT port n (“parallel connection”)
If you are using a standard printer cable connection, it is almost certain that you
should select LPT1.
File: to create file in a specified folder. Used if you need to capture output. The
folder into which label data will be saved should be selected by browsing to it. The
folder must be writable by all users.
Printer: to local or remote Windows printer (see below for specifying the target
printer).
IP: to TCP/IP Winsock (IP) to print directly to an Ethernet network attached printer. It
is recommended that the printer actually be installed as a Windows printer, printing
to the IP port.
“Alias” - used to ensure that data for different media types is directed to the correct
printer. If a template contains a line “printer=wristband” then data for that template will
be directed to the printer with alias “wristband”. Alternatively a line “printer=2” may be
included in the templates and data will then automatically be directed to the printer
specified on the second printer tab.
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“Type” – specifies the type of printer and used to convert Metaprinter templates to the
correct data for each printer type.
“Handshaking” (only visible if port is COM) – set to hardware or software.
“Folder” (only visible if Port is set to File) - to specify where files should be saved. Use
the Browse button to browse to the correct folder, which must be writable for all users.
“Address” (only visible if Port is set to IP) - with data as “IP_address:port” e.g.
192.168.1.194:9100
“Print Density” - specify the print density from the drop down list. It is a number from 130. The higher this number, the darker is the print on the label. Set 10 for LP2824
printers. Note that for EPL printers, values above 15 are treated as 15. ZPL printer accept
any value from 1-30.
“Use FlexaTrace” – If LabelTrace is e.g. running in a Terminal Services session but is
printing via FlexaTrace installed on the local workstation, this box should be ticked.
“Display clipping warnings” – When printing Metaprinter templates, the system can
detect if the data will not fit in the available space allowed in the design and will
provide a warning of this. Untick the box to suppress warnings.
“PadX” / “PadY” – These adjust where the image will appear on the label. The values
entered (in mm) will move the X and Y origin separately. This affects all Metaprinter
templates. Non-Metaprinter templates are unaffected. This only affects the local
workstation but see below for how to modify the templates themselves.
“Printer” (only visible if Port is set to Printer) – the Windows printer to be used. See
following section for guidance on specifying the target Windows printer.

Specifying the Target Windows Printer
There are many ways to specify the printer you wish to utilise. Note the following:- To use a USB port connection you must install the printer as a Windows printer.
- in a default printer installation, the printer may be named “Zebra LP2824” but there
are two spaces between “Zebra” and “LP2824”.
- It is often easiest to browse to a remote computer to select one of its shared printers
and install it as a network printer.
{in the examples below, the label printer is installed on a PC called Compaq with the
name “Zebra LP2824” but is shared as “LP2824”]

Normal LAN Client
1. Use the name of a locally connected printer as seen in the Windows printers folder,
eg “Zebra LP2824”, selecting it from the drop down list
2. Use name of installed network printer e.g. “Zebra LP2824 on Compaq”. This is the
recommended approach for network printers. This is interpreted in LabelTrace as
“\\Compaq\Zebra LP2824”. Note that you should not install a locally attached printer
and use a name with “on” in it, e.g. “labelprinter on PC” as this will be interpreted as
“\\PC\labelprinter” and so fail to print.
3. Use UNC path to shared printer on another workstation using
\\computername\sharename convention eg \\Compaq\LP2824
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4. Use UNC path to shared printer on another workstation using
\\computername\printername convention e.g. \\Compaq\Zebra LP2824
[NB this generally also works if the printer is NOT shared!]
5. Specify a printer attached to another computer even if it is not shared out, using the
“\\Compaq\Zebra LP2824” or “Zebra LP2824 on Compaq” name.

Terminal Services or Citrix Client
(LabelTrace will be running within the Terminal Services or Citrix session)
1. Specify a forwarded serial port, e.g. COM1. This requires V5.2 or higher of the RDP
client and MS Server 2003 or later.
2. Specify a forwarded printer e.g. “Zebra LP2824/Myworkstation/Session 11” can be
specified as “Zebra LP2824/Myworkstation” or selected from the drop down list of
printers. LabelTrace will only print to printers forwarded from the user’s session,
ignoring those forwarded from other sessions, if visible. (NB the Zebra label printer
installed as a Windows printer using the Zebra driver on the client will normally only be
forwarded if the TS server also has the Zebra driver installed – call our office for details
of a workaround).
3. Specify a shared printer using the “\\computername\sharename”;
“\\computername\printername” or “printername on computername” conventions.
4. Specify a printer attached to another computer whether or not it is shared out, using
the “\\computername\printername” or “printername on computername” conventions.

MS Word Printer Tab

This specifies the A4 report printer to which output will be directed when the template
specifies a Word mail merge document with LabelTrace fields and the merged document
is to be immediately printed.
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Advanced Tab

This entry confirms the paths to the database folder and the primary templates folder.
These will normally be greyed out to prevent them being modified. See your system
administrator if they need to be altered.
The “Use temporary template files” tick box should be ticked only if requested by your
Support Organisation to avoid specific issues sometimes encountered with server
behaviour.

Menu Bar Options
The Menu Bar at the top of the LabelTrace window has only two options, File and Help.
These lead to further options …

File > View raw data
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This presents a list of all the data passed in to LabelTrace from the system from which it
was launched.

File > Configure extensions

This presents a list of the installed “extensions” (script files) which require configuration
prior to use. These cover use of the emailing capability and, if appropriate, the clinical
system with which LabelTrace is to be used.

File > Shortcut Manager

This presents a list of installed shortcuts for launching LabelTrace with tools for adding
editing etc t these shortcuts. This is intended to make it easy to add e.g. shortcuts for
printing specific label templates direct from a shortcut which might be pinned to the task
bar for speed of access.
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For details on using this tool, see the document concerning this on the QuickTrace web
site.

Help > About

This shows useful information on the licenced options and on the program file versions
currently installed.

Help > About Extensions

This shows a summary of all the installed extensions with versions and whether the
extension will operate fully with the current installed licence. It may operate in demo
mode where the digits 1 and 0 are swapped and characters a and e are swapped. This
is useful for evaluation.
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Using the LabelTrace Management Utility
The LabelTrace Management Utility (LTMU) is used to manage the LabelTrace database.
It is generally only installed on one PC in a practice, e.g. the Practice Manager’s PC. It is
selected from the “Mgmt Utility” button on the LabelTrace Client window (if installed in
addition to the LabelTrace Client) or from the menu option…
“Start > All Programs > QuickTrace > LabelTrace > Management Utility”.
Fields in the LTMU are added/edited etc similarly
- to add an entry, click on the Add button then complete the fields as required and
click OK to save the new entry.
- to edit an entry, click on the entry to highlight it and click Edit. Modify the data as
required and click OK to save the new version.
- to delete an entry, click on the entry to highlight it and click Delete. Now click Yes
to confirm deletion of the entry or No to Cancel.
- to rearrange the order of entries, select an entry by clicking on it then use the
up/down blue arrows to drag the entry to the required position. They will be
displayed in this order for selection prior to printing.

On opening, the LTMU shows the Doctor field entries. To select another field for editing
use the “Fields” menu option and click on the Field name you wish to view.
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Doctor Field - Each entry in the doctor field actually comprises a set of fields These
fields hold the names and ID Numbers (as used by the labs) of doctors as they should
appear on labels and also a “username” field (username in the clinical system).

Premises Field - Each entry in the premises field actually comprises a set of fields
holding the address, telephone number and lab code of a surgery.
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User-definable Fields - Up to six user-definable fields may be utilised to provide
drop down lists at print time. These must be set up by selecting Fields > User Fields from
the menu bar. Click on the (currently blank) user field you wish to set up then click on
Edit. [N.B. - the Add and Delete buttons are deliberately greyed out.]

Now enter a name (e.g. “clinic”) for this field in the "Label" for the field (NB this is also
the field name as used within label templates - %clinic% in this example). Note that the
“Label” entry should be no longer then 12 characters or it may be partially obscured on
the LabelTrace window when printing is taking place. Optionally add a description of
the field. Click OK to save these settings.
If you now click on the Fields option on the main menu bar you will see a new field
listed corresponding to the "Label" for the field you edited. You may then enter data
items for the new field.
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Templates

This menu option provides a tree representation of a “primary templates folder” and the
sub folders which will provide the tabs in the LabelTrace menu system. The primary
templates folder (defaulting to that specified in LabelTrace, normally LTDATA) is
confirmed in the “Templates in” entry at the top of the window and is shown as “(main)”
in the tree. The Browse button at the end of this entry allows an alternative folder to be
viewed. Each folder may be expanded using the + symbol to reveal the files within it.
This is similar to File Explorer in Windows. These file names are presented as the label
template names on each tab in the LabelTrace client.
The “Backup” button allows creation of a backup of the template options in an XML file.
NB backups are created automatically when the LTPatch utility is used to add or modify
templates. For more details of this utility, see the QuickTrace Limited web site.
The “Restore” button allows the template options to be restored from one of these
backups.

By clicking on and dragging file names the order of files may be altered, thus altering
the presentation order in the LabelTrace menu system. While dragging, a line indicates
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where the filename will remain if the mouse button is released, as shown above.

Right clicking on a folder name presents a sub menu.
The options available are
- “Delete”, which will delete the entire folder of templates. A warning is given and the
user must confirm the action.
- “Read only”, which when set will prevent the files under this folder being edited via the
LTMU (options to are greyed when working with an individual template.
- “Create folder” allows a new tab to be created (the visible tabs in LabelTrace
correspond to folders in the system file structure)
- “Move template objects” allows the entire label design to be moved on the label by
specifying a translation distance in mm units for the vertical and horizontal axes. All
Metaprinter templates in the folder will be simultaneously modified Non-Metaprinter
templates are ignored and will be unaffected.
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Right clicking on an individual template provides a similar menu
The options available are
- “Delete”, which will delete the template. A warning is given and the user must confirm
the action.
- “Edit”, opens the template in a simple text editor for direct editing (see below).
- “Create folder” allows a new tab to be created (the visible tabs in LabelTrace
correspond to folders in the system file structure)
- “Move template objects” allows the entire label design to be moved on the label by
specifying a translation distance in mm units for the vertical and horizontal axes. If the
selected template is a non-Metaprinter template, it will be unaffected.

Note that double clicking an individual file name will also open it in a simple text editor
for direct amendment.
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Preferences
This option allows aspects of the system behaviour to be configured – these are global
settings.

The Confirm Patient tick box, when ticked causes a confirmation dialogue to be
presented each time LabelTrace is launched displaying basic patient details. In order to
proceed with launching LabelTrace with these details, the user must click OK to confirm
that the correct patient has been selected.
The “confirm patient with no CHI/NHS/H&C No” tick box, when ticked, requires the user
to confirm that they want to proceed when the patient data does not include the relevant
patient identifier.
The Lock Directories tick box controls whether the paths displayed on the Advanced tab
in LabelTrace Preferences may be altered by the user.
The Lock Printer tick box controls whether the printers selected on the Label Printers tab
in LabelTrace Preferences may be altered by the user.
The “Lock Close after…” tick box will cause this option to be greyed out on each
workstations, preventing users from changing the current setting.
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Help
The “Help” menu item launches the default web browser and loads the URL specified in
your LabelTrace system. This by default will be the document you are currently reading
or it may be a location or document specified by your local NHS organisation.

About
The “About” option provides version information and contact information for QuickTrace
Ltd.

Licence Menu Option (limited licence)
If LabelTrace has been supplied with a licence for a limited number of workstations,
then the LabelTrace Management Utility will display an additional menu option
“Licence” as shown below.
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Select “Licence > Edit machines …” to enable or disable printing from specific
workstations.

To enable a specific workstation for printing, highlight the workstation name in the
“unlicensed machines” list then click the Add button to move it to the “Licensed
machines” list. To disable a specific workstation for printing, highlight the workstation
name in the “Licensed machines” list then click the Remove button to move it to the
“Unlicensed machines” list
Note that you cannot move more workstations to the “licensed machines” list than your
licence allows.
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Installing the LabelTrace Client

Ensure that you are logged on as Administrator then browse over the network to the
server and into the folder "Ltinstl”. Double click the “setup.exe” file within the Ltinstl
folder to launch the QuickTrace Setup Utility. (N.B. on EMIS sites the LTINSTL folder is
often within the SHARED folder on the server. If necessary look at the Preferences
entries on an existing workstation to establish the path to the LTDATA folder which will
be the same as for the LTINSTL folder).

Untick the “Close this application after launching installer” option if you wish to also
install the Management Utility. Double click the Client entry (or click once then click the
“Install” button). This will launch the installer itself.

Click Next to commence installation.
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Click Next to accept the default location for Program files. Do NOT specify a remote
location, only a LOCAL drive on the workstation.

Click Next to accept the location of Central files. Do NOT edit this unless you are sure
you know why you are doing so!!!
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Select the systems for which you wish to install support on the workstation. Only the
printer types selected when the Central installation was carried out are displayed.

If printer support software is being installed, you must follow the instructions on the
installer which will run before continuing with the Client installer.

Click Finish to complete the installation

2. Configure the clinical system to launch LabelTrace. See details in the document
“Configuring Clinical Systems to Launch LabelTrace” in the LabelTrace Documents
section of the Support page of www.quicktrace.co.uk
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3. Launch LabelTrace with Dummy data via the tick box on the final screen above or via
the menu option:“Start > All programs > QuickTrace > LabelTrace > Test with dummy data”

Set the Preferences in the client from the Preferences button to the right of the on-screen
keypad. Note that in some circumstances, e.g. Vision Enterprise System, the dummy data
option is not available and you should set Preferences after launching LabelTrace from
the clinical system itself.

Deinstalling LabelTrace Client
To de-install LabelTrace Client, ensure that LabelTrace is not running and that you are
logged on as Administrator. Select Start/Settings/Control Panel/Add_Remove Programs
option. Select LabelTrace from the list of software which can be removed and click
"Add/Remove". Click OK to confirm and the deinstallation process will remove all
components. Note however that the LabelTrace folder and some files will not be deleted
if LabelTrace Management is still installed.
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Installing the LabelTrace Management Utility

1. Ensure that you are logged on as Administrator then browse over the network to the
server and on it the folder "Ltinstl\LT_Manager_Installer\Vxx" [xx is the version ID].
Double click SETUP.EXE (it has a CD icon) to begin installation. (on EMIS LV/PCS
sites the LTINSTL folder is normally within the SHARED folder on the server. If
necessary look at the Preferences entries on an existing workstation to establish the
path to the LTDATA folder which will be the same as for the LTINSTL folder).

Click Next to commence installation.

QuickTrace Ltd

0131 539 2537

info@quicktrace.co.uk

www.quicktrace.co.uk

[01/12/2015 - QT0032B.doc]

Click Next to accept the default location for Program files. Do NOT specify a remote
location, only a drive on the workstation.

Click Next to accept the location of Central files. Do NOT edit this unless you are sure
you know why you are doing so!!!
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Click Finish to complete the installation

Deinstalling the LabelTrace Management Utility
To de-install LabelTrace Management Utility, ensure that LabelTrace Management Utility
is not running and that you are logged on as Administrator. Select Start/Settings/Control
Panel/Add_Remove Programs option. Select LabelTrace Manager from the list of
software which can be removed and click "Add/Remove". Click OK to confirm and the
deinstallation process will remove all components. Note however that the LabelTrace
folder and some files will not be deleted if LabelTrace Client is still installed.
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